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1. Overview: What is Whirlwind WordSearch?
Whirlwind WordSearch is a powerful and easy-to-use word 
search puzzle maker.  It helps you create and print uniquely 
engaging word search puzzles from your own lists of words, 
and supports many different languages!  You will be building 
professional-looking puzzles right away. 

You can choose from a large number of built-in puzzle shapes, 
including circle, heart, diamond, crescent moon, pinwheel, and 
many more*. The puzzles can range in size from as small as 4 
letters across and down, all the way up to 50 by 50 letters*.  
You can even make them in many different languages. 

You can easily change how hard the puzzle is to solve. Just 
change the "Difficulty to Solve" setting and create a new 
puzzle, and the software automatically adjusts many subtle 
aspects of the puzzle.  This lets you quickly fine-tune your 
puzzles so they are appropriate for anyone from early learners 
to puzzle-savvy adults. 

Whirlwind WordSearch has some elegant features that create "classroom-safe" high-quality 
puzzles. It double-checks every created puzzle, and removes any randomly-created "naughty 
words."  And as you increase the difficulty setting, it will add more tricks into the puzzle, ensuring 
a tougher solving experience. 

You can save your word search puzzles for opening 
again later or sending to friends. When you re-open 
them, you can print them, or create brand new 
puzzle shapes and sizes from the same word list. 
You can also easily export high-quality puzzle and 
answer images into your own specialized word 
processing documents for re-printing in books, 
newsletters, the web, or classroom handouts. 

Let's find out how to make some great puzzles! 

* Note: Some features are not available or are limited in 
the Lite version of this software. 
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2. One-Page Tutorial: Let's make a puzzle
This section will show you how to start a new puzzle, add some words, customize how the puzzle 
looks, and then generate and print the puzzle.  After this one-page tutorial, you will be ready to 
learn about some of the more advanced features in Whirlwind WordSearch, which are described 
later in sections 3 and 4. 

1. Start: Find the Whirlwind WordSearch application in your "Applications" folder, 
and double-click its icon to run it.  When it starts, it will open a new empty 
document for you, and will display it on the screen in a window called "Untitled".  
This document will hold your word list and its generated puzzle. 

2. Title: Click the "Titles" tab, and  type in a title of "Zoo 
Field Trip - Furry Mammals". 

3. Add Words:Click the "Words" tab, and type in some 
words in the “word list” box below.  For now, just type in 
the following words, either separated by commas or new-lines: Bobcat, 
Wolf, Bear, Lemur, Gnu 

4. Difficulty: Click the "Difficulty" tab, choose "Basic" difficulty, and set the 
"Difficulty to solve" slider to "4. Medium". 

5. Layout: Your longest word (Bobcat) is 6 
letters long, which means your "puzzle 
width" must be at least 6 letters or bigger.  
So, set the "Puzzle width" slider to 9 for 
extra room, and choose a "Circle" Puzzle 
Shape.  

6. Create: Click the [Create] button at the bottom center of the window, and the Preview area will 
show your created Puzzle, or the Answer with the corresponding answer words circled.  Each 
click of Create will make a different puzzle layout. 

7. Print: You can now choose the [Print] button at the bottom center of 
the window to print the puzzle and answer pages to your printer.   

There it is!  Creating your own customized word search puzzle is as easy 
as that! 

Oh, but wait… there is much more that you can do with Whirlwind 
WordSearch!  Keep reading and learn how to unlock many more powerful 
features, and you will quickly be creating world-class word search 
puzzles. 
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3. Specific Tasks: Tell me how to...
Whirlwind WordSearch offers the beginning user an easy way to quickly make and print a puzzle 
without much work… and also offers the power-user many powerfully advanced features for 
generating high-quality puzzle graphics for newsletters, books, or other publications.  Many 
different users with many different needs have many questions they would like answering. 

To help answer the questions many of you may have, this section offers you sets of step-by-step 
instructions for doing a variety of things with Whirlwind WordSearch. 

3.1. Create a new puzzle
Each new puzzle document that you create will hold a single list of words, and an 
accompanying puzzle configuration.  Each document is displayed in its own window. You can 
create, save, and work on many different puzzle documents, one at a time, or have many open at 
once. 

To create a new puzzle document, you can: 

a. Run Whirlwind WordSearch, and it will automatically create a new "Untitled" puzzle 
document. 

-or- 

b. If Whirlwind WordSearch is already running or if it automatically opens a prior document 
you were working on, simply choose "New" from the "File" menu, and a new "Untitled" 
puzzle document will be created for you. 

Now you are ready to enter your words, configure the puzzle options, print it, and save it if you 
like. 

3.2. Save a puzzle I am working on
If you have entered a word list and customized the layout of a puzzle, you may want to save 
your work to a file on your computer, in case you want to open it and work on it or print more 
copies later.  Maybe you aren't done filling out the word list yet, or you want to share your 
puzzle file with a friend who also has a copy of Whirlwind WordSearch.   The file can be saved 
even if you've only entered some words and not yet created a puzzle.  This allows you to quit 
the application, then return to the puzzle file again later and continue working on it. 

• After making changes to the puzzle document, choose "Save" from the File menu. 

• If this was a new document and the first time you've saved it to disk, you will be prompted for 
a file name.  Type in a name, choose a location on your disk, and click the Save button.  The 
file is created and your word list and puzzle settings are stored there. 

• Or, if you have opened an existing document and you were just making some changes to it, 
then when you choose "Save", it will quietly update your existing document in-place with the 
new changes, without prompting you for a file name. 
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The saved puzzle file will look like this on disk: 

The document will stay open after you save it so that you can keep working on it. 

3.3. Open my saved puzzle document to edit or print
• Using the Finder, find the puzzle document that you want to open. 

a. Double-click your document to open it with Whirlwind WordSearch. 

-or- 

b. Drag and drop the puzzle document icon onto the Whirlwind WordSearch application to 
open it.  You can drop multiple documents and they will all open together, each in its own 
separate window. 

-or- 

c. Run the Whirlwind WordSearch application, and from the File Menu, choose "Open...", and 
navigate to the folder and puzzle document you want, select it, and click the "Open" button. 

• Your puzzle document is opened and displayed in a window, and the puzzle is re-created to be 
exactly the same as when you last saved it.  If you had saved it without first creating a puzzle, 
opening it now it will leave the puzzle empty until you are ready to click the Create button. 

3.4. Save a copy of my puzzle to a different document
You may want to start with one puzzle document, but then save the changes you make into a 
second new (copy) document, without altering your original puzzle document. 

• Open the original puzzle document, as in section 3.3 above. 

• Make any changes for the new document copy. 

• Choose "Save As..." from the File menu (do not choose "Save" because that will simply update 
onto your existing document.) 

• You will be prompted for a new file name to save this file as.  Type in a file name different 
from the original document. 

• A new document will be created and written to a new file (and your original file will be left 
unchanged.) 

You have now "switched over", and you are now working with the new document copy.  This 
means that when you now choose "Save", your changes will be written to this new document 
copy, not the original. 
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3.5. Make a very easy puzzle
Very easy puzzles are likely targeted at an audience that is just learning to read.  You can set this 
up with the following options: 

• Go to the "Word List" tab.  Enter a small number of short words in your word list.  Try 3 to 5 
words that are 3 to 5 letters long. 

• Go to the "Layout" tab.  Set the "Puzzle Size" to something fairly small, perhaps from 5 to 8.  
Note that the larger the "Puzzle Size" you choose, the smaller each letter becomes on the 
printed puzzle, since the entire puzzle will automatically shrink to fit onto a page.  You may 
also want to choose a sans-serif font that is easier to read, and turn off the "Print letters in 
lower-case” checkbox. 

• Go to the "Difficulty" tab.  Switch to "Basic" mode.  Set the "Difficulty to Solve" slider to 
"Very Easy" or "Easy".  This setting will only place words left-to-right or vertically-down.  It 
will also fill the rest of the puzzle with letters that are not in the word-list words, making the 
puzzle easier to solve. 

• Click the Create button to build the puzzle. 

3.6. Make a very hard/tricky puzzle
Very hard puzzles are best suited for seasoned adult puzzle-solvers, and can be set up with the 
following options: 

• Go to the "Word List" tab.  Enter a large number of words, from 10 to 30 words of any length. 

• Go to the "Layout" tab.  Set the "Puzzle Size" to something large, between 20 and 35.  Note 
that the larger the "Puzzle Size" you choose, the smaller each letter becomes on the printed 
puzzle, since the entire puzzle will automatically shrink to fit onto a single printed page. 

• Go to the "Difficulty" tab.  Set the "Difficulty to Solve" slider to at least "Harder", or up to the 
"Diabolically-Difficult" setting.  These settings will place the words in any of the 8 compass & 
diagonal directions, and will fill the rest of the puzzle with letters that are in the word-list 
words.  If you choose one of the highest two difficulty levels, it will also sprinkle additional 
short pieces of your words into the puzzle as deceptive "decoy wordlet" patterns. 

• If you want to make the puzzle visually more unique and ornate: Under the "Layout" tab in the 
Puzzle Letters group, choose an unusual font, and possibly turn on "Print letters in lower-
case”. 

• Or, you could turn on "Advanced" Difficulty Mode, and choose the word directions and 
overlaps, decoys etc.  See section 4.3, Advanced Difficulty. 

• Click the Create button to build the puzzle. 

Sometimes a puzzle that you design is so complicated that it takes Whirlwind WordSearch a 
long time to create it.  In these cases, it will display a progress bar in the middle of the window, 
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and continue placing your words in millions 
of different patterns until it finds a solution 
that fits all the words in, while removing 
duplicates and naughty words. 

However, if it still cannot fit all your words 
into the puzzle, it will eventually give up 
and display an error message.  If this 
happens, you can adjust some of your 
puzzle settings (different puzzle size, 
different shape, different difficulty, or fewer 
words), or just try your luck again and click 
"Create" to try building it once more.  If it is 
"busy generating" and you want to interrupt its progress and make some changes, just click the 
"Cancel" button, and the puzzle will stop building. 

3.7. Print my finished puzzle to the printer
After you have opened a puzzle document and created a puzzle layout that you like, it is time to 
print the puzzle and answer key to the printer.  You do not need to save your document to disk 
before printing, however, it is usually a good idea to save your work from time to time, and just 
before printing is a good time.  To save before you print, follow the instructions in section 3.2 
above. 

• Go to the "Page Details" tab and ensure that the "Print the Puzzle Page" and "Print the Answer 
Key Page" are turned on.  If both are turned off, or if you have not yet created a puzzle, then 
the Print button and menu item will be disabled, because there is nothing to print. 

• You can now print by either: 

a. Clicking the [Print] button at the bottom of the window. 

-or- 

b. Choose the "Print..." option under the File menu, and click the Print button. 

-or- 

c. Press the <command>-P keys on the keyboard. 

• Make any changes you need in the print dialog, and click the Print button. 

You could instead choose to save the output as a PDF document (for attaching to an e-mail, for 
example).  See section 3.21 below for how to do this. 
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3.8. Copy a word list from a web page (or document) into my puzzle
There are many places to get lists of interesting words for use in a word search puzzle.  You 
may already have your own list of words in a word processing document, or you may want to 
find a list of words on the internet.  Simply follow these steps to get a list of words from 
somewhere else into your word search puzzle. 

• Create a new puzzle document, as described in section 3.1 above. 

• Now find the word list you want to copy from: 

a. Open your word processor, and open the document that contains your list of words. 

-or- 

b. ...do a search on the web for "free word search" or "vocabulary words" and find one of 
many sites that gives a list of words that appeals to you.  There are many word list 
collections freely available (not copyrighted) for you to use. 

• Let's say we are studying words starting 
with the letter "A", and now have the 
following word list to use from a web 
browser: 

• In this window, click just above the 
upper left of the word list and drag down 
to the lower right, selecting the list of 
words you want to copy (see the blue 
selection above.) 

• Now choose "Copy" from the Edit menu. 

• Switch back to Whirlwind WordSearch, 
click the "Words" tab and click inside 
the Word List box, and choose "Paste" 
from the Edit Menu.  The words will 
show up in your word list area now.  You 
can now edit your word list, adding or 
deleting words to suit your needs. 

• Note that the words must be separated 
by commas or new-lines.  If they are not, 
you will have to reformat them in the 
text box before the list is ready to create 
a puzzle from. 

• Click the Create button, and you have a word search puzzle ready to go! 
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3.9. Automatically use the most words possible from a big word list
Perhaps you want to copy or type in a large list of words, and let the software pick the biggest 
set of those words that would fit in the puzzle size and shape you choose.  You can do this by 
tagging some or all of your words as being "optional", and have Whirlwind WordSearch use as 
many words as it can to make a puzzle. 

• If you want to control which words are required, and which ones could be optionally left out, 
you can individually mark each word you wish to be optional by prefixing it with a '+' 
character.  These marked words will then be considered "nice to have" in the puzzle and not 
required if they don't fit.  When the puzzle is created and it finds that there are too many words 
to fit into the size and shape you chose, it will remove one of your optional words and try 
building the puzzle again.  When choosing which optional word to remove, Whirlwind 
WordSearch will find the longest optional word to remove first.  This guarantees that the 
fewest number of optional words are removed before successfully making your puzzle.  It will 
remove more optional words, one at a time, and retry until it is successful.  If it has removed 
all the optional words and still cannot build the puzzle, it will then issue an error message that 
it "could not build the puzzle even after dropping all your optional words from the list.”  If this 
happens, you could either make more words optional, or increase the size of the puzzle. 

-or- 

• If you want to make all the words optional, and just see which words it can fit, you can turn on 
the “Make all words Optional in word list” checkbox under the “Words” tab.  This will treat all 
of your words as optional, and it will fit as many as it can. 

If any optional words were dropped, you can view a list of the omitted words, by clicking the 
"Show Removed 'Optional' Words” button, which will appear just under the Puzzle and Answer 
Preview display. 

Clicking that button will display a 
sheet that lists which words were 
removed when creating this puzzle.  
You can select these words and copy 
them, in case you wish to paste them 
into another list or puzzle. 

You can also visit the "Stats" tab  (see section 4.7) to see the "# of optional words removed”. 

3.10. Create a puzzle in a different language
Whirlwind WordSearch can create word-search puzzles in many different languages… not just 
English or the language your computer is set to use.  This makes it easy for you to make puzzles 
for foreign language vocabulary studies. 
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• First you must tell Whirlwind WordSearch which language you want to use for your puzzle.  
Choose the "Words" tab, and then choose the 
Language/Alphabet you want to use from the 
popup menu.  Choosing the language does 
several things:  It selects which alphabetic 
letters are allowed in your words; It tells it 
which letters to fill the rest of the puzzle 
with;  It also tells it which language's 
"naughty words" to look for and remove 
from the puzzle.  You have now switched 
Whirlwind WordSearch to expect your words 
to use a new language/alphabet. 

• Next, you need to tell your Macintosh to 
let you type the letters from this newly 
chosen alphabet.  To do this, first open 
the “System Preferences” panel in your 
dock.    Now choose the “Language and 
Region” item, and add the language you 
want from the "Preferred Languages" (or 
older "Input Sources") list.  Either drag 
the one you want to the top of the list, or 
if it isn't listed, click the [+] button at the 
bottom of the list to add it first. 

• To make an easy shortcut to switch 
languages, go to the "Keyboard" section in the "System Preferences" panel, and under the 
"Input Sources" tab, turn on the "Show Input menu in menu bar" option at the bottom of that 
tab. 

• Now from the menu bar at the top of your screen, choose the same 
input language here for your computer, that you chose in 
Whirlwind WordSearch for your words. 

This will allow you to type letters in that alphabet.  Now you can click in 
the word list box of Whirlwind WordSearch and start typing your words 
in this new language. 

When you are finished, you can switch back to your regular keyboard language again via the 
"Input Menu" you just added. 

3.11. Add a “Secret Message” within my puzzle
One interesting variation that you can add to your word search puzzle is to lay a message into 
the remaining spaces between the word list words.  That way, after all the words have been 
found and crossed out, some or all of the remaining letters will spell out a message that you 
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provide.  Your message is started at the left side of the puzzle, and letters are always laid across 
from left to right, line by line down the puzzle, skipping over any puzzle words, until the entire 
message is added to the puzzle.  If your message does not completely fill the puzzle, then the 
remaining puzzle spaces around it are filled with extra letters, just like a regular word search 
puzzle.   Only the alphabetic letters of your typed secret message are used;  Any punctuation or 
spaces or letters that are not in your current alphabet are automatically skipped/removed. 

You can optionally add a prompt on your printed puzzle page, alerting your reader to also look 
for your secret message.  To enable this prompt feature, go to the "Secret Message" tab and 
under “Prompt to display on printed puzzle page” simply type a short hint that you want printed 
on the puzzle page.  You may want to type something like "After finding the movie words, find 
the famous movie quote." 

To help you see where your message will show up, it can be 
displayed in the Preview area with a darker gray 
background so it is easier for you to see where it is 
positioned.  Show the Preview Answer, by turning on 
"Preview as: Answer" at the top of the preview area.  Then 
under the Preview area, turn on “Show secret message”.  
Here is an example, showing your words placed in the 
p u z z l e ( c i r c l e d ) , a n d t h e s e c r e t m e s s a g e 
"FURRYMAMMALS" in darker squares filled in around 
the words: 

To print this gray box highlighting in the final printed 
Answer key, go to the "Secret Message" tab, and turn on the 
checkbox: "Highlight Secret Message on Answer" 

To add your own secret message to a puzzle, do the following: 

• Create a new puzzle document, as described in section 3.1 above, and add Bobcat, Wolf, Bear, 
Lemur, and Gnu to the word list. 

• You will now “hide” the message “Furry Mammals” in the rest of the puzzle.  Click the “Secret 
Message” tab, and type “Furry Mammals” into the text box: 

• You can a l so choose the 
"position" popup menu to change 
where the message shows up in 
the puzzle: near the top, near the 
bottom, centered in the middle, 
or at a random position, or you 
can require it to exactly fill every 
empty space in the puzzle. 

• Now set the size and difficulty and shape of the puzzle in the “Layout” and "Difficulty" tabs, 
and create the puzzle. 
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• If Whirlwind WordSearch can successfully fit your words and your secret message in around 
the words, it will display the “Puzzle Preview” with darkened squares where your secret 
message was added. 

If your Secret Message is too long for the puzzle and number of words, such that there is not 
enough free space to add the entire message, then the puzzle will not be generated and you will 
get an error letting you know of the problem. 

If you chose to "Exactly Fill" the secret message 
text, the software will lay in all the words, and 
then attempt to lay your secret message in to 
exactly fill all remaining spaces in the puzzle.  If 
the secret message is too short or too long, you 
will see an error message telling you how many 
letters to add or remove.  You can then change the 
puzzle size or shape, overlapping behavior, length 
of the secret message, or add/delete word list words, and re-create the puzzle until you get it just 
right.  As you type letters in the secret message box, an “approx. space remaining” prompt 
displays below the text box, helping you determing how much space you have left. 

Note: This feature is not available in the Lite version of this software. 

3.12. Create many different puzzle layouts from the same word list
You might wish to use a single word list and create a number of different puzzles from it.  
Perhaps you are passing them out to a classroom and want to discourage cheating, or you may 
just want to add variety by choosing different shapes for each.  The technique below assumes 
that you simply need to quickly print a bunch of different puzzles and their answer keys from a 
single word list, and then be done. 

• Create a new puzzle document, and type in your word list. 

• Make your initial set of changes in the different tabs to set up your first puzzle. 

• In the "Page Details" tab, you will want to turn on the option "Print the Puzzle Page", and  
probably turn on "Print the Answer Page" too if you need the corresponding keys to each 
puzzle. 

• Click the "Create" button to make your first puzzle. 

• Go to the File menu and choose the "Print" menu item to print this puzzle. 

• Now make the changes you want to set up the next puzzle, change its shape, or simply click 
the Create button again to create a different puzzle layout. 

• Now go up to the File menu and choose "Print" again, and print this new puzzle. 

Repeat these last 2 steps, changing the puzzle and printing again, as many times as you need.  
Note that each puzzle and answer page you print will share the same "Specific Puzzle 
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Identification Number" (SPIN) printed at the bottom of the page.  This lets you match up the 
puzzle and its associated answer key. 

For a related way of creating many puzzles, see the tip at the end of section 3.15. 

3.13. Export puzzles & answers into my page layout document for publishing
You may have a newsletter that is yearning for a puzzle page, or perhaps you want to add a logo 
and your own text along with the puzzle.  Or you may want to create a number of different 
puzzles, and publish them in your own book.  In these instances, you will want to extract just 
the puzzle, the word list, and its associated answer key, and paste them into a separate word 
processing document, so you can do your own fancy page layout with them. 

• Using Whirlwind WordSearch, customize and create the puzzle that you want to add. 

• From the Edit menu, choose the 
"Copy Formatted>" item, which 
will open a sub-menu of more 
options.  These options will let you 
copy the word search puzzle grid 
and answer grid as high quality 
PDF images to the clipboard.   
Choose "Copy Formatted> Puzzle 
Grid" . 1

• You must copy the puzzle grid, 
answer g r id , and word l i s t 
separately.  This is because you likely want to place the word list above, below, or wrapped 
around the puzzle, with a different font size, etc. and the answer grid as a different size at the 
end of the book.  So keeping each puzzle item separate will give you this extra page layout 
flexibility. 

• Now start up your word processing or page layout application, and open the document that you 
want to add the puzzle to. 

• From your word processing application, choose "Paste" from the Edit menu, and move and 
resize the resulting puzzle "object" to its final spot in your document. 

• You can also choose Edit> Copy Formatted> Word List as Text.  You can then paste this into a 
text-box in your page layout software.  The word list will be formatted just as you set it in the 
"Page Details" tab regarding case, numbering, sorting, etc.  This allows you to change its 
position, size, font, color, etc. in your page layout software. 

 You could also copy these by typing the keyboard shortcuts <Command>-1, <Command>-2 or <Command>-31
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Here's an example of the puzzle dropped into a newsletter with an interesting background 
showing through: 

You can repeat this Copy-and-Paste process to copy the puzzle's word list and answer key into 
your word processing document.  If you are creating a booklet of puzzles, you can easily create 
and copy-and-paste any number of your puzzle creations this way. 

-or- 

For even more advanced 
o p t i o n s a n d w o r k - f l o w 
flexibility, you may want to 
export the puzzles and/or 
answer keys to separate files, 
and import those files into other 
software where you can lay it 
out nicely for publishing.  
Exporting gives you additional 
file format options, and much 
h igher reso lu t ion /qua l i ty 
options, useful when importing 
to other publishing software. 

After generating a puzzle you 
like, you can export a copy of it 
via the File:Export Files... 
menu item.  You will be presented with an Export window, with a number of options you can 
alter to choose what to export and the format to export. 
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NOTE!  Before we continue, there is something you should 
know about copying the puzzle this way.  This copied puzzle 
is a "vector object", not a "bit-mapped object".  This is good 
and bad news. 
The good news is that when you copy this puzzle into your 
word processor and resize it, it will retain a crisp high-
quality look.  That is, it will not look fuzzy or blocky, but 
will remain sharp.  It also only copies the letters and lines, 
so if you paste it over a background texture, the background 
will show through nicely, which is often what you want (see 
the example to the left.) 
The bad news is that because the letters and lines are thin 
and it is an object "full of holes", you may find it difficult to 
click on a part of it to select it and move or resize it.  Try 
increasing the magnification or "zoom level" in your word 
processor to make it easier to grab and move this object. 
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As you change these settings, they will be remembered for future exports.  And along the top is 
a box holding the proposed filename example and the currently chosen file size and format.  
These will change as you update any of the settings below. 

Write Puzzle File [x] and Answer File: The puzzle file will always be exported, and here you 
can also enable the automatic exporting of the answer file too.  They will have the same file 
names, ending in either “_1Puz” or “_2Ans”. 

Width and Height of exported graphic file…:  This "size" setting lets you choose how large the 
puzzle image will be when you export it.  This is only used for the image formats (PNG, JPEG, 
PDF, SVG.)  The text-based formats don't need or use it.  See section 3.13 above for more 
information on exporting puzzle files. 

Puzzle export file format:  You can choose what file format to use when saving your exported 
puzzles and answer keys. 

PDF:  This is a high quality (vector) publishing file format, readable by many word processing 
and page layout applications. 

PNG, JPEG:  These are graphic image file formats, readable by many photo and image editing 
and word processing and page layout applications. 

SVG: This is a vector graphic file format readable by many web browsers and some page layout 
and graphic editing applications.  It is non-interactive, but can be directly added to a web 
page, or imported and used to create an interactive game, or even into CNC or 3D 
printing machines.  Let your creative imagination chew on that for a while!  It is 
important to note that SVG format, unlike PDF and PNG/JPEG, cannot capture and use 
your computer’s fonts for drawing letters, so the font used in SVG is a generic font.  You 
can manually edit the SVG file after export and alter the font specification to your needs. 

Note: The size and format are limited in the Lite version of this software. 

File name starts with: This string will be used as the beginning of both the puzzle and answer 
export file names. 

Add export-counter to exported file name: Turn this on to add an export-counter into the file 
name that increments each time you export.  This lets you build multiple puzzles with the same 
puzzle setup, and export each of them with automatically-unique filenames, e.g., 
“MyPuzzle_1_1Puz.png”, “MyPuzzle_2_1Puz.png”, “MyPuzzle_3_1Puz.png”. 

Export-counter starting value: This lets you choose a starting value for the export-counter that is 
added to your filenames. For example, if you set this to 222, then every time you start the 
application and start exporting, your first exported puzzle files will start with that export-
counter value, e.g., “MyPuzzle_222_1Puz.png”.  Then each time you export again, the files will 
get the next-higher export number, e.g., “MyPuzzle_223_1Puz.png”, etc. 
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Add SPIN to exported file name: Turning this on will append the current SPIN number to the 
file name too, so you can easily export and compare multiple saved files from one document, 
that may just differ by the SPIN, i.e., where the words got placed. 

Choose directory for export files: This lets you pick a directory to write all your exported 
puzzle/answer files. 

Note: Just like the Edit:Copy command above, the export command will export just the puzzle 
or answer grid image.  It will not include your title or your word list, since it is assumed you 
will be laying out the puzzle in your own fancy ways.  You can separately extract your word list 
by either (1) selecting the words in the Word List text box and copying them, or (2) choosing 
Edit:Copy Image of:Word List, or (3) choosing Edit:Copy Puzzle/Answer as Text and 
pasting the entire text block into a text editor, and extracting the formatted ordered list of words. 

Exporting will be disabled if you have not yet created a puzzle. 

3.14. Make the application remember my settings for all new puzzles
You may be creating many puzzles that all have the same shape, size, and difficulty level, or 
even the same title and subtitle, and you don't want to set those options each time you start the 
application with a new document.  Here's how you can have Whirlwind WordSearch 
"remember" your current settings and use them for all new puzzles. 

• Open a new empty puzzle document, or open one you have already created. 

• Make any needed changes under the different tabs to reflect how you want new puzzle 
documents to be preset. 

• Now, under the "Whirlwind WordSearch" menu, choose "Remember Current Settings", and 
most of these settings  under the tabs will be remembered on your computer and used when 2

you create any new puzzle documents. 

If you need to make changes to these presets, simply make the changes you want and choose 
the "Remember Current Settings" menu item again, and it will remember these new settings, 
until you "remember" different settings later on. 

3.15. Hide a word in the puzzle, but not shown in the word list
There are times when you may want to put extra words into the puzzle without having them shown 
in the word list.  For example, you may want to add several "unlisted" bonus words in the puzzle, 
giving extra credit for those who find them.  Or, you may want to add your name or company name 
in there as a kind of "copyright watermark".  This is easy to do. 

• Simply put an asterisk "*" at the beginning of a word (with no space between the asterisk and 
the first letter), and that word will become "hidden" in the word list.  It will be placed in the 

 Your "word list" is not remembered with this technique since you usually want different words for each puzzle.  If you do 2

want to create many puzzles with the same word list instead, see section 3.12 above.
_____________________________________________________________________________________________________ 
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puzzle, but will not show up in the printed word list or in the 
answer key.  For example, if you wanted the word "wookie" 
to be in the puzzle, but not show up in the printed list of 
words to find:  lemur,  gnu,  bobcat, *wookie,  wolf,  bear 

• You can also choose to optionally have your hidden words 
shown on the printed/exported Answer Page.  For example, 
you may want to temporarily do this and print a single master 
answer key just for yourself, showing all the words, hidden or 
not.  To do this, simply choose the "Page Details" tab, and 
turn on the checkbox labeled: "Show Hidden words in the 
Answer Key".  Any "hidden words" (e.g. "wookie" in the 
example above) will then show up in the printed answer key 
with a solid gray background behind them.  Remember to toggle it back off if you want to print 
the answer key without them shown. 

• You may want to see the hidden word placement in the Preview Answer, but not highlight the 
hidden words in the final printed/exported Answer page.  To do this, turn off the "Page 
Details:Show Hidden words in the Answer Key" checkbox, and turn on the "Show hidden 
words" checkbox under the Preview area. 

You can quickly hide/remove any of your words by prefixing them with an asterisk, wherever they 
are in your word list.  Just remember that although they are not listed in your final word list, they 
are still placed in the puzzle. 

Tip: This could also be used to create several different customized puzzles from a single large word list, 
just by moving the asterisks to different sets of words and re-creating a new puzzle. 

If you find yourself wanting to have a certain word or words always hidden in all of your puzzles, 
you can do this by adding the words via the "Hidden Words" pane of the Settings window.  See 
section 4.9, Settings:Hidden Words for more information. 

Note: This feature is not available in the Lite version of this software. 
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3.16. Solve my puzzle on-screen without printing it
There are times when you may want to create a word 
search puzzle just for yourself and quickly solve it 
visually on the computer.  In this case, you do not 
want to see the answer, just the puzzle.  This is easy to 
do. 

• First change the “Preview as” style at the top of 
the Preview area to “Puzzle.” 

• Next, turn off all the checkboxes under the 
Preview area that display extra indicators on the 
puzzle. 

• Now add your words and create a word search 
puzzle.  It will be displayed on-screen without the 
answer key or any other hint lines added. 

• Once you have visually found all the words, or if 
you need  to peek at the answer key for a hint, 
change the “Preview as” style to "Answer", and 
they will all be shown.  Switch it back to “Puzzle” 
to hide the answers. 

3.17. Add a compound word with a space/hyphen/apostrophe
Sometimes you may need to add a single “compound word” (composed of multiple words), 
normally separated by a space, hyphen, or apostrophe (sometimes called a "single quote 
character".)  In the printed word list, you would want the compound word displayed intact with the 
space/hyphen/apostrophe shown.  However, inside the puzzle, you want it removed and have the 
words run together along the same line. 

For example, consider the hyphenated word X-RAY.  This word will show the hyphen in the printed 
word list as "X-RAY", but will be hidden inside the puzzle as "XRAY".  The hyphen will be left in 
the word for display, and removed when it is put in the puzzle. 

If your word has an apostrophe ('), for example O'Hara, then the apostrophe will be left in the word 
for display, and removed when it is put in the puzzle, treated just like the hyphen.  Note that it must 
be the regular apostrophe, and not a “smart/curly” single-quote character which word processors 
often use. 

Finally, to allow a compound word (or phrase) containing spaces, Whirlwind WordSearch requires 
that you separate each "word" in the word list with either a comma, or a new-line.  It will collect all 
the letters and spaces in between, and treat it as a single compound word or phrase.  For example, 
to use the compound word "Blue Jay" as a single word, enter it as "Blue Jay," in your word list, and 
it will display as "Blue Jay" in the printed key, and and will be "BLUEJAY" in the puzzle. 
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Note: You can even create a word search puzzle of phrases instead of single words by separating each 
phrase with a new-line or comma, e.g. “Stanley Kubrik, It’s full of stars” 

3.18. “Lock” the word layout while changing other puzzle aspects
What if you created the perfect puzzle layout and the answer key is sent out, but your editor now 
wants you to change the font used for the puzzle letters, or show (or remove) the grid lines and re-
print the puzzle? 

This can be done.  Many aesthetic aspects of the puzzle can be changed, and the puzzle can be re-
created without changing the layout of the words.  Here's how. 

Once you have generated a puzzle you like, and 
want to 'lock the words into place', simply go to 
the "Page Details" tab, and near the bottom, click 
"Choose your own SPIN below". 

This will lock in and keep using the current SPIN 
value used for this puzzle, and therefore re-use the 
same word layout pattern for all future puzzles, no matter how often you click "CREATE". 

Then you can change display-related things like Title/subtitle text, puzzle letter font, secret message 
hint style, or the grid display, and then re-create the puzzle, and your word search words will still be 
in their original place, based on that unchanging SPIN value. 

Note: If you change other aspects of the puzzle though, a whole different puzzle layout will be created 
from that same SPIN value. For example, if you change the puzzle size, shape, difficulty, or change any 
of the words or secret message or secret message position, the puzzle must change its layout.  This is 
because Whirlwind WordSearch has to re-check the new words or secret message text and find new 
places for them to guarantee no accidentally created duplicate or naughty words snuck into the new 
positions. 

3.19. Create a puzzle with only number sequences
You may want to create a puzzle consisting only of numbers, to offer a puzzle with a different 
kind of challenge.  

First, under the "Words" tab, choose "Numbers (Arabic)" from the top "Language/
Alphabet for Word List" section. 

Then, enter your list of number sequences in the word list, separated by spaces, 
commas, or new-lines.  The rules for lists of numbers are the same for lists 
of words;  Each must be at least 2 characters long, cannot have 
duplicates, and cannot be longer than the puzzle dimension, etc. 

Choose the rest of the puzzle settings, like font, color, difficulty, 
and click the Create button, and Whirlwind WordSearch will 
make a numbers-only puzzle. 
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3.20. Create a puzzle with "Word Clue" phrases for the words
You may want to create a puzzle of words, but instead of 
printing the list of words to look for, you instead want to 
print "word clue" phrases for the words.  The user would 
then have to guess the word from the clue, then find the 
word in the puzzle, making the  puzzle a tougher 
challenge.  Note that although the puzzle words must be 
composed from letters of the chosen alphabet, the word 
clue phrases can be any text in any alphabet, so you can 
have the clues be in a completely different language if 
you wish.  

To start, you must enter each word and its associated clue 
together on a single line.  The word comes first, followed 
by a colon character ( : ), and then the word's clue 
phrase, followed by a new-line.  For example: 

Choose the rest of your puzzle settings, like font, color, difficulty, then click the Create button, 
and Whirlwind WordSearch will make the puzzle with your words, as usual. 

Now under the "Page Details" tab, change the popup 
menu under "Puzzle Page Printing" from "Print 
words" to "Print word clues".  This changes only how 
the puzzle will print, and does not affect the 
generated puzzle at all.  When you print the 
completed puzzle, it will now print your clues 
instead of your words on the puzzle page.  Note that 
on the Answer page, both the clues AND words will 
be combined and printed together. 
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If you add clues to one or more words, they must all have clues.  If you forget to add a clue to 
the end of one of your words, you will get an error that highlights the word just after the word 
where you forgot to add the clue, which looks like this: 

Note: The "Print word clues" feature is not available in the Lite version of this software. 

3.21. Save the puzzle page as a PDF file for e-mailing or printing later
What if you want to save your nicely laid out puzzle and answer pages as a file that you can 
send to somebody else, but they do not have this software?  Maybe you want to take the puzzle 
to a copy/print center to get color copies printed?  Here’s how to save the puzzle and/or answer 
pages as a PDF file, readable by other computers: 

• Set up and create your puzzle 

• Under the Page Details tab, turn on "Print the Puzzle Page.”  If you want to print the answer 
page, then also turn on "Print the Answer Page”.  If you want a separate PDF file for the 
puzzle and the answer pages, then do this section twice, and select the Puzzle page, then do it 
again selecting the Answer page. 

• Choose "Print" from the File menu. 

• At the lower left corner of the Print dialog, click the "PDF" 
popup, and choose "Save as PDF" from the menu. 

• Pick a file name and location, and it will write the two printed 
pages as a single PDF document. 

Note: If you want the Puzzle Page and Answer Page saved as two separate documents, do these steps 
twice, once by turning on the Puzzle Page and printing to PDF, and again by turning on the Answer Page 
and printing to PDF. 
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3.22. Remove distracting diacriticals from the puzzle
Many non-English languages use special letters 
with diacritical marks over them.  These are good 
for allowing you to spell some more complicated 
words properly.  Whirlwind WordSearch normally 
leaves your word’s diacriticals intact when they 
are added into the puzzle, since removing a 
diacritical can sometimes change the meaning of 
the word.  However, people using some languages 
expect all diacriticals to be removed when making 
their word search puzzles .  So, here is how you 3

can remove the diacriticals from the puzzle to 
make it “cleaner” looking: 

• First, set up your puzzle and add your word list 
words properly spelled with their diacriticals 
intact.  This will insure that they are displayed 
properly with their diacriticals in the word list. 

• Then under the Layout tab, 
turn on “Remove a l l 
diacriticals from letters”. 

• Optionally to be extra tidy, 
under the Difficulty tab, 
c h o o s e “ A d v a n c e d 
Difficulty Mode" and 
choose to Fill the puzzle 
with “Only your fill-
letters…”.  Then look at 
the under “fill-letter 
subset” letters at the 
very bottom of the 
Advanced box, and 
delete any letters in the 
box that you do not 
want used as fill-letters. 

 For example, Italian word-search publishers!3
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• For example, change it to look like this: 

• Then, when you create the puzzle, none of your words or the extra fill letters will have 
diacriticals in the puzzle. 
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4. Detailed Reference: What does this button do?
This section offers more detailed descriptions of each of the tabs and their individual options.  You 
can also hover your mouse over different options and menus, and a "tool-tip" text box will give you 
more information about that item. 

4.1. Titles Tab
The Titles tab is where you choose the title and subtitle to print above your puzzle on the printed 
page.  They are optional and can be blank. 

Printed Puzzle Titles

Title/Subtitle: You can enter text in the Title and Subtitle/Decription fields, and that text will be 
printed at the top of your printed puzzle pages.  You can also leave either or both fields blank, since 
they are optional.  The title field is printed in a slightly larger font size, while the subtitle is a little 
smaller allowing more text on the subtitle line.  If you type in title or subtitle strings that are too 
long, the text will wrap to a second line at the edge of the page when it is printed.  Tip: If you want 
a lot of title text and no subtitle, you can leave the title string blank, and instead use the subtitle 
string for your text, giving you more room for longer text, and also reduce the Title/Subtitle "font 
size adjustment" slider to shrink the font for even more room. 

Font: You can print the title and subtitle text using any font that is installed on your computer.  
Please note that not every font can display alphabetic letters in languages other than English, so you 
may need to experiment to see which ones work and look best for your purposes.  

Title/Subtitle/word list color: Click the color-well to pick a new color to be used for the titles and 
the word list.  Note that the color of the letters within the puzzle grid are set separately;  See the 
Layout tab below. 

Centered title text: Turn this on to center the printed title and subtitle.  Turn it off for left-
justification, useful for multi-line subtitles. 
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Font size adjustment: Fine-tune the size of the printed title and subtitle text.  Sliding it down to 
the left will make the text grow smaller, and sliding it to the right of center will make it grow larger.  
An approximate display of how the text will print is shown above the puzzle in the Preview area. 

Note: The "font size adjustment" is not available in the Lite version of this software. 

As an example, if you typed the following in the Title and Subtitle fields: 

then the top of the printed page would look like this: 
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4.2. Words Tab
The Words tab is where you choose the language used for your word list, and where you enter the 
list of words you want placed into the puzzle.  It is easy to enter your words into the puzzle.  Click 
on the "Words" tab, then choose a language/alphabet from the popup menu, then click in the word-
list text box and start typing each word. 

Language/Alphabet

The "Language/Alphabet for Word List" box (near the top) lets you choose a different language 
(and alphabet) from the popup menu, and it displays all the letters you may use in your word list 
and hidden message.  When you choose a different language/alphabet, the list of allowed letters will 
change to match your new alphabet choice.  It also switches to a special list of "naughty words" just 
for that language, and uses that list to find and remove any randomly created ones from each puzzle 
you generate. 

Your Word List

Your words must only use the letters available in the alphabet you choose, but they can be upper 
case, lower case, or mixed case.  Each word must be separated from others by either a comma or a 
new-line.  Your word capitalization and your ordering of words will be preserved when they are 
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printed as a list on the puzzle and answer pages (unless you choose to alphabetize and capitalize 
them via "Page Details" tab.)  Of course, when the words are placed inside the puzzle grid, the case 
of their letters will all be upper-case, unless you chose the "Print letters in lower case" checkbox. 

You can also copy a list of words from a word processing document or from the internet.  Just copy 
the words from the other application, then switch to Whirlwind WordSearch, click in the word-list 
text box and choose "Paste" from the Edit menu, and the words will be added to your list.  See 
section 3.8 for detailed instructions on how to do this. 

If you are creating a special word search puzzle that displays a list of "word clue" phrases instead of 
the list of words themselves, you must enter each word (and its associated clue phrase) on a 
separate line.  See section 3.20 for detailed information on this special case. 

Whirlwind WordSearch also checks your entire word list for duplicate words, including words that 
are the same as another word reversed, for example, "tool" and "loot".  This is because words can 
be laid into the puzzle going left to right and right to left, and those two words could look like 
duplicates inside the puzzle.  These will create an error message.  You can overcome this by turning 
on the "Allow duplicates" checkbox under the word list. 

You are allowed to enter non-alphabetic punctuation into the word list and secret message text 
boxes too.  Whirlwind WordSearch is very lenient, and allows you to type or copy/paste any 
characters into the word list box.  However, before you create a word search puzzle, you may need 
to remove extra characters that are not part of your words.  The list should include only your words, 
separated by new-lines or commas. 

There are special cases for the space, hyphen (-, or dash), and for the apostrophe (', or single-quote).  
These characters will be left in the word for word-list display, but removed when it is put in the 
puzzle grid.  For more information, see section 3.17.  

A word search puzzle's size must be at least as large as the letters of your longest word, otherwise 
that word will never fit in the puzzle.  Whirlwind WordSearch does check all of your words against 
the puzzle size you have chosen, but only after you click the Create button.  This gives you freedom 
to type long words and then change the puzzle size without being interrupted by annoying error 
messages.  Only when you create the puzzle do any problems get detected and reported to you. 

The “Approx. space remaining" number (above the word list) gives you a rough estimate of how 
many letters are left in the current puzzle based on the words you entered and the puzzle's current 
size and shape.  As you add words to your word list, the number shrinks to show you are running 
out of room in the puzzle. It also shrinks as you add text to your secret message, which needs room 
in the puzzle too.  This is just an approximate indicator, and does not prevent you from adding 
many more words than the currently-configured puzzle could hold.  It cannot predict how many 
words might wind up overlapping until you finally create the puzzle.  This looseness allows you to 
later mark certain words as optional (see section 3.9) or as hidden (see section 3.15.) 

After you click the "Create" button, Whirlwind WordSearch will attempt to create the puzzle and 
determine if it really can fit all your words in.  If not, it will then give you an error message stating 
that it cannot place all your words.  You can then fix the problem in a number of ways;  Go to the 
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Layout tab and increase the puzzle size and/or try a different shape that has more space, or increase 
the difficulty level (which allows words to overlap and go in additional directions), or remove some 
words or make some optional, then create the puzzle again. 

After you have successfully created a puzzle, the total number of words you entered will be listed 
under your word list.  This is to help you verify that all your words or phrases were entered 
correctly, and that you got the number that you expected. 

Optional Words

Under your word list is the checkbox “Make all words optional in puzzle” which is an option that 
you can turn on to have Whirlwind WordSearch fit as many words as it can to build a puzzle, then 
show you which words it could not fit.  See section 3.9 for more details about working with 
optional words. 

Note: This feature is only selectable in the Full version of this software. 

Duplicate Words

Word search puzzles are usually built from a list of unique words.  However, you may want to 
create a puzzle that has two or more copies of the same word or words in the puzzle, or if you want 
to enter words that are mirrored (e.g. adding "tool" and "loot".) You can allow this by turning on the 
checkbox "Allow duplicates in word list". Whirlwind WordSearch will no longer check for 
duplicate words, but instead will add every instance of any word you type, however many copies 
there are.  It will also display each copy in the printed word list. 

Copy Formatted Word List

This will copy the word list as a formatted carriage-return-separated list to the clipboard, which you 
can then paste into another document.  The words will be capitalized and sorted and numbered per 
your choices in the Page Details tab.  This button is available after you create a puzzle. 
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4.3. Secret Message Tab
The "Secret Message" tab allows you to enter a word, phrase, or sentence, and have it also 
embedded into the puzzle, after all your puzzle words are laid out in place.  It lays the letters out 
left-to-right, filling in around any word search words already laid into the puzzle. 

Secret Message: Enter your secret message text here. Only the alphabetic letters of your typed 
secret message are used;  Any punctuation or spaces or letters that are not in your current alphabet 
are automatically skipped/removed. 

Approx space remaining: Shows roughly how many letters available for your secret message, 
based on the words you entered and the puzzle's current size and shape.  As you add text to your 
secret message, this number shrinks to show you are running out of room in the puzzle. It also 
shrinks as you add words in your word list, since they need room in the puzzle too.  You must first 
build a puzzle once to let Whirlwind WordSearch calculate how much space is taken by your words 
and secret message.  After that, this will automatically update as you type. 

 See section 3.11 above for an example of adding a secret message. 

Position of Secret Message in puzzle: You can change where the message shows up in the puzzle: 
near the top, near the bottom, centered in the middle, or at a random position, or you can even 
require it to exactly fill every remaining space in the puzzle. 

Highlight Secret Message on Answer: If you have added a 
"Secret Message", then turning this on will print the secret 
message with gray cells behind each letter.  It will be shown this 
way in the answer Preview area and will also be printed on the 
Answer page.  If turned off, then the secret message will not be 
specially highlighted this way, and will simply look like all the 
other random fill letters. 

Prompt to display on printed puzzle page: If you have added a 
“secret message”, this will let you choose what "Secret Message" 
text prompt to print on the puzzle page (under the word list), 
which lets the user know that there is more to look for.  You can 
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leave this empty to not print print anything, or type a hint to look for a secret message, or simply 
print the full secret message itself.  If you added no secret message string (it is empty) then no 
prompt text will print on the puzzle page. 

Note: The "Secret Message" feature is not available in the Lite version of this software. 
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4.4. Difficulty Tab
The "Difficulty" tab lets you change how tricky the word search puzzles are to solve.  You can use 
the "Basic Difficulty Mode", which lets you simply move a slider from "very easy" puzzles to "very 
hard" puzzles, without worrying about all the details of how it works.  If you want more control, 
you can switch to the "Advanced Difficulty Mode", which lets you control each of the fine-grained 
"difficulty options" yourself.  Both the Basic and Advanced modes are covered below. 

Basic Difficulty Mode - Difficulty to Solve

Changing the "Difficulty to Solve" slider will alter several obvious and not-so-obvious aspects of 
the generated puzzle.  You can change the puzzle from very easy to solve (for younger children) 
through diabolically difficult to solve (for experienced adults.)  Each of the difficulty levels creates 
a puzzle with the following features: 

Very Easy (across): Places words only left-to-right.  The remainder of the puzzle is filled 
with letters of the alphabet that are not in the word list (making it much easier to find the 
words), or filled with your optional secret message.  It also ensures that none of your 
words overlap each other.  This easy level is perfect for beginning readers. 

Very Easy (down): Places words only top-down.  The remainder of the puzzle is filled 
with letters of the alphabet that are not in the word list (making it much easier to find the 
words), or filled with your optional secret message. It also ensures that none of your 
words overlap each other.  This easy level is perfect for beginning readers, and especially 
for Japanese language puzzles. 

Easy (across & down): Places words left-to-right or top-down.  The remainder of the 
puzzle is filled with any letters of the alphabet, or filled with your optional secret 
message.  No words are allowed to overlap. 

Medium: Places words left-to-right, top-down, or the two forward diagonals from left-to-
right.  The remainder of the puzzle is filled with any letters of the alphabet, or filled with 
your optional secret message.  No words are allowed to overlap. 

Hard: Places words in 6 of the 8 possible directions (4 compass directions and 2 left-to-
right diagonals.)  The remainder of the puzzle is filled with any letters of the alphabet, or 
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filled with your optional secret message.  A few words are allowed to overlap. 

Harder: Places words in any of the eight possible directions (4 compass directions and 4 
diagonals.)  The remainder of the puzzle is filled with letters of the alphabet that are from 
your words (making it harder to find the words), or filled with your optional secret 
message.  Some words are allowed to overlap.  It also sprinkles in occasional short pieces 
of words from your word list, creating deceptive "decoy wordlets" to throw your puzzle-solvers off 
the track as they look for the words.  For more information on "decoy wordlets", see "Advanced 
Difficulty Mode" below, or section 4.6. 

Very Difficult: Places words in any of the eight possible directions (4 compass directions and 4 
diagonals.)  The remainder of the puzzle is filled with letters of the alphabet that are from your 
words (making it harder to find the words), or filled with your optional secret message.  Many 
words are allowed to overlap, and there are more decoy wordlets. 

Diabolically Difficult: This uses the same tricks as 'Very Difficult' above, and after placing your 
words, it tries to fill up to half the remaining empty puzzle space with decoy wordlets. 

Note: There are fewer difficulty choices available in the Lite version of this software. 

Advanced Difficulty Mode

Switching to this mode replaces the "Basic" difficulty slider above with its individual settings 
below, letting you change each of the difficulty parameters separately.  This gives you much finer 
control over how your puzzle is created. 

Note: The "Advanced Difficulty Mode" is not available in the Lite version of this software. 

Word directions arrows: You can choose which directions are available to place the words.  
Simply click on any of the direction arrows to toggle that direction "on" or "off".  At least one 
direction must be left on of course, but other than that, any combination of directions is allowed.  
The words for this puzzle will be placed only in one of these chosen directions. 

Word overlap: You can change how many words overlap (word-crossings) in the puzzle.  Easy 
puzzles usually have few or no overlapping words, which requires a slightly larger puzzle size to fit 
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all the non-overlapping words.  Harder puzzles generally will have more overlapping 
words, and are more compact.  Setting the overlap to "Lots" will attempt to overlap 
almost every word with another word, if possible.  It tries to overlap words by 
looking for identical letters shared between two words.  Of course if you have a word 
that has no letters in common with any other words, Whirlwind WordSearch will 
issue a sad, quiet little sigh, roll its eyes and dice, and quietly place the word in a 
non-overlapping position instead.  Setting the overlap to "All" will require every 
word to overlap some other word, and if this is not possible (for example, you still 
have that word that has no letters in common with any other words) then Whirlwind WordSearch 
will issue an error that it could not create a puzzle with all words overlapped. 

Allow overlapped words along same direction: Turn this on to allow overlapping words to join at 
any angles, including along the same direction (collinear.)  Turn this off to insure that overlapped 
words will always be at odd angles to each other.  With this off it makes it easier to distinguish 
overlapping words on the answer key, which otherwise might run together and look like a single 
long word. 

Allow embedded sub-words in word list: Turn this on to allow words in your word list that also 
appear inside other words in your list, like "beard" and “ear”, or even “Tarp” and “Rat” (since "rat" 
is reversed inside the word "tarp".)  When allowed, Whirlwind is allowed to place "rat" completely 
inside "tarp." Turn this off to detect and flag these possibly-embedded words in your word list as 
errors. 

Fill puzzle with: Here you can choose how to fill the remaining puzzle in different ways: 

• Non-word letters: Uses any letters from your alphabet that are not already used in your words. 

• Only your fill letters: Uses any letters from your fill-letter subset. 

• Only your fill letters+Decoy Wordlets: Uses any letters from your fill-letter subset, and adds 
decoy wordlets. 

• Any letters+Decoy Wordlets: Uses any letters from your alphabet, and adds decoy wordlets. 

• Only word letters+Decoy Wordlets: Uses any letters that are used in your words, and adds 
decoy wordlets. 

# of “Decoy Wordlets”: "Decoy Wordlets" are short pieces of words from your word list, sprinkled 
into the puzzle to throw your puzzle-solvers off the track as they look for the words.  They are 
added in the empty areas between your words, along with the other "fill letters", and after any 
"Secret Message" has been laid in.  You can change how many of these are added, from none, up to 
"lots".  If you set it to "lots", it will attempt to fill up to half the remaining empty puzzle space with 
these decoys.  This option is only enabled if you chose to add them via “Fill Puzzle With” above. 

Your fill-letter subset to use (from the chosen alphabet): Here you can add or remove letters 
from this list that would normally be used to fill the rest of your puzzle.  This subset will be used 
when you set the "Fill puzzle with" menu to items that refer to “fill letters”.  This list is initially set 
to every letter of the chosen alphabet, without the diacritical letters.  Each of these letters must be 
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from your chosen alphabet.  You can add letters, or delete any letters that you don't want to use as 
fill letters, but you must leave at least a few letters here to allow random filling to work. You may 
enter either upper or lower case letters, since they will be automatically converted and stored as 
lower case. 

For example, in French, you may want to add the letter ç to the alphabet to randomly fill with.  Or, 
if you want to fill the rest of the puzzle with only the letters A, B, and Z, then you would set the 
"Fill puzzle with" menu to "non-word letters", and then set this text field to "abz". 

Tip 1: If you had already removed some letters and now want to refill it with the default full alphabet, you 
can simply return to the "Words" tab, change the "Alphabet" to another language, then back to your own, 
and it will reset this field with the alphabet of letters (except those with diacriticals.) 

Tip 2: If you want to quickly add all the diacriticals too, you can simply tap the Words tab, select, copy and 
paste the entire alphabet line from the “Alphabet/Font Example” display, and paste the list of letters here. 
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4.5. Layout Tab
The Layout tab contains the most common customization settings you might want to change for 
your puzzle.  There are many more settings under the "Difficulty" and "Page Details" tabs, which 
are covered in other sections. 

Puzzle Layout (Shape and Size)

Square puzzles with shapes vs. Rectangular puzzles 

If you choose the "Square puzzle" option, you can create puzzles in a variety of sizes and pre-made 
"cutout shapes", and they will each fit inside a square grid, where the width and height of the 
puzzle are the same.  See “Puzzle Shapes” below. 

If you choose the "Rectangular puzzle" option, you can create rectangular-shaped puzzles and 
choose different widths and heights (for long or tall rectangular puzzles.)  With this option, you 
cannot choose any of the "cutout shapes";  Your puzzle will be a rectangular box shape with your 
chosen aspect ratio. 

Puzzle Width and Puzzle Height 

This sets the total size (number of letters available) for the puzzle.  If you are making Square 
puzzles, then the width and height will both change together for you.  The height or width must be 
at least as large as the number of letters in your longest word, since a word that is any longer than 
the puzzle size would never fit.  Whirlwind WordSearch will allow you to start typing in long words 
and then change the puzzle size.  It is not until you are finished and click the Create button that it 
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double-checks whether your longest word will fit.  At that point, if a word is still too long for the 
current puzzle size, it will it give you an error dialog, telling you what the problem is and how to 
fix it. 

Remember, the bigger the puzzle size, the more letter spaces are available, and therefore the more 
words can fit into the puzzle.  Also, as you increase the size of the puzzle, the overall font size of 
the letters in the printed puzzle and answer grid will automatically shrink, in order to fit the entire 
puzzle onto a single printed page. 

Puzzle Shape: 

If you choose the "Square puzzle", you can then pick a shape other than the default "Square" shape. 

The available shapes are: Square, Circle, Bow-tie, 
Rectangle Tall/Wide, Heart, Diamond, Pinwheel, X, 
UL-Wedge, LL-Wedge, UR-Wedge, LR-Wedge, 
Square-hole, Donut, Checkers, Crescent, Plus-sign, 
Right-Arrow, Left-Arrow, Up-Arrow, Down-Arrow, 
Up-Triangle, Down-Triangle, Cross, Onion Dome, 4-
Clover, Square-Peg, Round-Hole, Mushroom, Oval-
Easy, Oval-Up, Trapezoid, Pentagon, Hexagon, 
Octagon, 4-star, 5-star, 6-star, Chevron-Up, Chevron-
Down, Chevron-Left, Chevron-Right, Rainbow-up, Rainbow-down. 

When you choose one of these non-square shapes, there are not as many available letter spaces in 
the puzzle.  If you have long words or many words, they may not all fit in these other shapes.  To 
compensate for this and still fit your words in, you will need to increase the puzzle dimension a 
little.  Also, many of these shapes will look nicer & smoother at larger puzzle sizes. 

Note: The complete set of shapes are available in the Full version of this software. 

Puzzle Letters

Font: You can display the puzzle letters using any font that is installed on your computer.  Please 
note that not every font can display alphabetic letters in languages other than English, so you may 
need to experiment to see which ones work and look best for your purposes.  As you switch fonts, 
the puzzle grid will immediately re-display in this new font.  

Color: Click the color-well to pick a new color for the puzzle and answer letters inside the puzzle 
grid.  

Print letters in lower case: Turn this on to print the letters of the puzzle and answer in lower case, 
instead of upper case.  You may want to turn this OFF for younger puzzle solvers. 

Remove all diacriticals from letters: Turn this on to strip any diacritical marks from your words 
when they are added to the puzzle grid.  The diacriticals are always left in-place when your words 
are displayed in the word list.  This “simplified” puzzle display is commonly used in some 
languages, e.g. Italian.  Leaving this off will leave any diacriticals in the letters of  your words 
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when placed in the puzzle grid.  To add/remove any diacriticals in the fill-letters around your 
words, see the related topic “Your fill-letter subset to use” under the “Advanced Difficulty” section 
4.4 below, or section 3.22 above. 

Font size adjustment: This feature lets you fine-tune the size of the letters in the puzzle/answer 
grid.  The basic font size is automatically chosen for you based on some factors (size of puzzle, size 
of printed page), but you may find this calculated size "not quite right" for your needs.  Perhaps the 
font you chose is a little larger or smaller than other fonts.  The slider's center position is regular 
size.  Sliding it down to the left will make the letters grow smaller, and sliding it to the right of 
center will make them grow larger. 

Font vertical adjustment: This feature lets you fine-tune the vertical position of the letters in the 
puzzle/answer grid.  Sliding it down to the left will slide the letters below center, and sliding it right 
will slide them above center.  This can be useful if you have an unusual font that doesn't display 
quite centered vertically, and you need to nudge the letters up or down a bit inside the grid. 

Puzzle Grid

Grid line size: Click the popup menu to choose a new line thickness (in points) for the separator 
(grid) lines around each letter on the puzzle.  If you choose "None", it will draw no grid lines 
around the puzzle.  Note that it will always draw grid lines around the Answer Key, since they help 
show you where the answer words are in the puzzle.  0.5 is a very thin line, and 4.0 is a very thick 
line. 

Draw only shape outline: Turn this on to draw just the outline around the shape, without inner grid 
lines around letters.  Turn it off to draw grid lines around every letter in the shape. 

Grid line color: Click the color-well to pick a new color for the puzzle and answer "grid lines". 

Add cell fill color: Turn this on to fill each cell square with an opaque background color for 
printing and for exported image files.  If it is on, you can click the color-well to pick a new color 
for the cell-fill color.  If this is off, the cells are transparent and any background will show up 
behind the letters. 
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4.6. Page Details Tab
The "Page Details" tab contains many more detailed printed-page options.  Although you may not 
use them as often, they can offer you flexibility in fine-tuning the look of your printed puzzle. 

Note: If you want to see what your printed puzzle will look like without having to print to real paper first, 
you can first choose to print, and in the print dialog, choose "PDF: Open in Preview" to see the final 
puzzle/answer pages printed to a separate PDF document on-screen. 

Puzzle Page Printing

Print the Puzzle Page: Turn this on to print the page containing the puzzle itself.  Turn it off to 
completely skip the printing of the puzzle page, for example, if you just need to re-print the answer 
page. 

Print word list on the Puzzle Page: Turn this on to print the list of words underneath the puzzle 
grid on the Puzzle page.  Turn it off to print just the puzzle without the word list underneath.  Note 
that there is a separate checkbox to control the Answer page word list. 

Print Separator Lines: Print separator lines between title, puzzle, and word list on the printed 
puzzle and answer pages.  Turn this off to have no separator lines printed there. 

Print SchwanSongs Logo: Turn this on to display the "SchwanSongs" company logo at the bottom 
of the printed puzzle and answer pages. 
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Note: This option cannot be turned off in the Lite version. 

Alphabetize the printed word list: Turn this on to print the list of words sorted in alphabetical 
order.  If this is off, the words will be in the order you listed them in the "Word List".) 

Print word list as all upper-case: Turn this on to fully capitalize the list of words when they are 
printed.  If this is off, the words will remain capitalized as you typed them in the "Word List".)  
This option will be disabled if you have chosen an alphabet that does not have upper/lower case. 

Add numbering to word list: Turn this on to add numbering (1,2,3,4) before each word in the 
printed word list.  If this is off, the words will be listed without any numbering. 

Print as a list of: Here you can choose how the word list is displayed under your puzzle, and how 
it is formatted if you copy it to the clipboard via the menu item “Edit:Copy Formatted word list as 
text”.  The word list can be a single line separated by commas, which might be best for puzzles 
with lots of long words or a large word list font size.  It can be words separated one-per-line in 
columns, which looks best if you have them numbered as well.  Or if you are using the Word Clues 
feature, you can show just the word clues, not the words.  For more information on the “Word 
Clues" feature, see section 3.20 above. 

Word list font size adjustment: This feature lets you fine-tune the size of the printed word list 
words.  The font size is automatically chosen for you based on several factors (number of words, 
length of words, size of puzzle), but you may find this calculated size "not quite right" for your 
needs.  Maybe there is one really long word that stretches into the word in the next column and you 
need to shrink the size a bit.  Maybe there are lots of short words, and you want to bump the size up 
for younger or older readers. 

The center position is regular size.  Sliding it down to the left will make the words grow smaller, 
and sliding it to the right of center will make them grow larger.  This also gently adjusts the font 
size of any secret message printed under the puzzle too.  If you wish to preview what the change 
will look like, you must choose "Print", and review the "Print Preview" window to see the change, 
then cancel the print dialog. 

Answer Page Printing

Print the Answer Page: Turn this on to print the page containing the answer key.  Turning this off 
will skip the printing of the answer key page altogether.  This is useful if you already printed it and 
don't need to print it again, or if you have no need for the answers, just the puzzle. 

Print word list on the Answer Page: Turn this on to print the list of words underneath the answer 
grid on the Answer page. 

Print Puzzle Letters: This lets you choose how the answer key is filled with “non-answer letters.”  
The remaining letters can either be NEVER shown, or they can be shown in a DIMMED gray color, 
or they can be shown ALWAYS, the same color as the answer letters.  Note that if you set this to 
NEVER, then the grid-lines will automatically turn back on for the answer key, to help you see 
where the words are relative to the shape. 
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Print Hidden words in the answer: Normally, any words that you have marked as "hidden" (with 
a leading asterisk) in your word list will be hidden (not printed) in the word list and will be hidden 
in the answer key.  Turning this on will show (and print) the hidden words in the answer key, and 
will be highlighted with an oval background.  They will still be omitted from the printed word list. 

Answer highlight style: You can highlight the answer key words with 
"hollow outlined ovals", "solid ovals", or "strike-through lines", whichever 
you prefer. 

Answer highlight size: You can adjust the size/thickness of the hilighting, 
to make it thinner or thicker than the regular size. 

Answer highlight color: Click the color-well to pick a new color for the oval/strike-through lines 
drawn under the placed words in the answer key. 

SPIN

Print the "SPIN" at the bottom of Puzzle/Answer pages: Turn this on to list the Specific Puzzle 
Identification Number, or SPIN, at the bottom of the printed puzzle and answer pages.  Each SPIN 
value specifies a unique placement of the words in the puzzle, and can be used to exactly re-create a 
particular puzzle layout.  It also is the same number for a puzzle and its answer.  Think of it as a 
kind of serial number for the puzzle and answer.  This number can be printed at the bottom of the 
puzzle page and its answer page, so you can easily match up each puzzle page with its answer page. 

Automatically pick a new SPIN for each puzzle: Turn this on and the software will automatically 
pick a new random Specific Puzzle Identification Number (SPIN) for you each time you create a 
new puzzle.  This number is used to choose a particular word solution layout. 

Lock in your own SPIN: Enter a decimal integer number in the box, between 1 and 16 digits long.  
Once you set your own SPIN value, then each time you click the Create button the SPIN value will 
stay the same, and the puzzle's word layout will also stay the same (for a particular puzzle size, 
shape, and difficulty setting). 

When you have turned this option on, a small warning 
will display at the top of the set of tabs, reminding you 
that your puzzle configuration is now "locked" in a 
certain configuration. 
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4.7. Stats Tab
This tab displays a number of statistics about the generated puzzle.  If no puzzle has been created 

yet, then this page will be empty. 

Puzzle Shape: The name of the puzzle shape you chose. 

Puzzle Size: The width and height of the puzzle in letters. 

Puzzle Alphabet: The name of the alphabet you have chosen to use for the puzzle words. 

SPIN: The Specific Puzzle Identification Number, used to exactly re-create a particular puzzle 
layout.  See section 4.6 under SPIN for more information. 

Difficulty: The level of difficulty used (1-8, or advanced). 

Total Words Added: A count of how many words from your word list that got placed into the 
puzzle. 
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Total Unique Letters from Words: A count of how many unique letters you used across all the 
words in your word list. 

# Optional Words Dropped: A count of how many +optional words from your word list could not 
be placed into the puzzle, and were dropped from the list.  

Unique Letters from Words: A consolidated list of each unique alphabetic letter used across all 
the words in your word list. 

# Decoy Wordlets added: While the puzzle is being created in the highest difficulty modes, the 
software sprinkles some pieces of each of your word list words as "decoys" into the puzzle, to trick 
the puzzle solver.  This number is a count of how many decoy wordlets were added.  The positions 
of these added partial words can be shown in the preview window by turning on the "Show Decoy 
Wordlets" checkbox, described in section 4.8. 

Total Overlapping Letters: How many letters overlap (i.e. are shared between words) in the 
generated puzzle. 

Total Letters in Puzzle: A count of how many letter spaces there are in the current puzzle's shape.  
For a 10x10 "Square" shape, this would be 100 (10 wide by 10 high.)  For a 10x10 "Circle", it will 
be a little less (76) since the rounded corners are not filled with letters. 

Remaining Spaces in Puzzle: A count of how many letter spaces there are in the current puzzle's 
shape that are not part of the placed words.  This is a count of all the empty spaces between the 
words, that normally get filled with random letters, or with your "secret message".  Although this 
number can vary by a few spaces each time you make a new puzzle, it gives a good idea how many 
letters are available for the "secret message phrase" if you want it to exactly fill that space. 

Percentage of Puzzle Filled: The total percentage of letters in the puzzle that are filled with letters 
from your words, or in other words, how densely the puzzle is filled with your words.  The higher 
the percentage, the longer it will take to generate the puzzle. 

# of Zapped Duplicate Words: A count of how many duplicate words it found and removed from 
the generated puzzle.  These "eliminated" word positions can be shown in the preview window by 
turning on the "Show postions of removed duplicate words" checkbox, described in section 4.8. 

# of Zapped Naughty Words: A count of how many naughty words it found and removed from the 
generated puzzle.  These "eliminated" word positions can be shown in the preview window by 
turning on the "Show removed 'Naughty Words'" checkbox, described in section 4.8.  Of course if 
you are making a word search puzzle with a list of naughty words, those naughty words you 
intentionally added in your word list will remain in the puzzle, since you wanted them there! 

Total Naughty Words List: A count of how many naughty words that Whirlwind WordSearch 
knows about and can eliminate for the language you chose.  This includes any "excluded words" 
you added in the Settings window. 
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4.8. Preview as Puzzle / Answer
The right side of the window displays a preview of the generated puzzle, or its answer key.  If you 
create a new puzzle, or make changes to the puzzle in the various tabs, they will be shown here. 

This shows what your puzzle and answer will look like when you print or export it.  It also shows 
the optional puzzle title and subtitle which will be printed above the puzzle.  You can always click 
the "Create" button again until you see a puzzle layout that you like before you decide to save or 
print it. 

Preview As (Puzzle or Answer): Choose the “Puzzle” radio button to see the puzzle itself, with no 
answer highlighting.  Choose “Answer” to display what the answer key will look like, displaying 
the positions of the words with your chosen highlight style. 

Preview Display Checkboxes

Below the preview display are 
some checkboxes that can add 
some display details to the preview 
area.  Changing these checkboxes 
does not affect the final printed puzzles, only what is shown in this preview window.  These 
controls can show some of the "behind-the-scenes" work that Whirlwind WordSearch does to create 
your puzzle. 
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Show removed "Naughty Words": Turn this on to highlight (in light red strike-through) any 
"naughty word" that was detected and removed/altered during the puzzle-making process.  The 
displayed word will already be "altered" to no longer be "naughty." Of course, any naughty words 
that you intentionally added into your word list will remain in the puzzle, since you wanted them 
there… this only removes naughty words that were randomly added when filling the rest of the 
puzzle.  The internal list of naughty words that are detected is based on the language you chose to 
make the puzzle (see section 3.9.) 

Show "Decoy Wordlets": Turn this on to highlight (in light green strike-through) any partial 
"decoy wordlets" that were added during the puzzle-making process.  

Show removed duplicate words: Turn this on to highlight (in light blue strike-through) any 
accidentally-randomly-created duplicate of one of your words that was found during the puzzle-
making process, that were altered/removed. 

Show # removed “Optional” words:  If there 
were optional words in your word list that were 
removed in order to create the puzzle, this button 
will be displayed just under the preview area.  
Click it to bring up a dialog that lists the removed 
words.  You can select and copy this list from the 
dialog, in case you want to paste these words into a new puzzle’s word list. 

Show secret message: Turn this on to highlight your secret message with a gray background in 
each cell.  This setting only affects the Preview display, not your printed/exported Answer. 

Show hidden words: Turn this on to highlight (in light Answer highlight style) any words you 
marked as "Hidden."  This setting only affects the Preview display, not your printed/exported 
Answer. 
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4.9. Menu Items
The menus along the top "menu bar" contain special commands for opening/saving/printing puzzle 
documents, etc.  Here are descriptions of the items specific to Whirlwind WordSearch. 

Whirlwind WordSearch: About Whirlwind WordSearch

Choose this item to display a window that gives credit to all the people who helped make this 
software happen… watch them scroll by and wave as you listen to the fun parade music I wrote. 

Whirlwind WordSearch: Settings4

Choose this item to open a window that lets you change application-specific settings. When you set 
the values here, they are used for all future runs of Whirlwind WordSearch for any of your 
documents, until you change them again here. 

Settings: Appearance:

Textured window background: Turn this on  to add a wood-grain finish to the main window.  Turn it 
off to have a flat finish.  This is aesthetic on-screen only, and does not affect the printed/saved 
puzzles.  This setting change is immediately remembered, and all future documents and launches of 
the app will use this setting.  Unlike the other document-specific settings, this is saved for the 
application, so it will affect the look of the windows, no matter which documents you open.  After 
50 years, it is time for wood grain finishes to be popular again (however, orange and avocado-green 
are forever gone.) 

Settings: Extra Hidden Words:

You can add extra words here that will always be added to every puzzle you make, and will always 
be hidden, that is, not highlighted in the answer key.  You can have a different set of words for each 
language/alphabet you choose.  Each word must be on a separate line and must only consist of 
letters from the currently chosen language/alphabet.  This can be useful for adding your name into 
every puzzle you make, as a kind of watermark, for example. 

 Note that Settings used to be called Preferences, and Apple recently (in MacOS 13/ Ventura) changed this name.4
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Note that it is possible to accidentally add a word that is too long or has letters from other than your 
currently-chosen alphabet or is a duplicate of other words in your word list.  These problems will be 
detected later when you try to create the puzzle, and will be displayed via an error message. 

Note: This feature is not available in the Lite version of this software. 

Settings: Excluded Words:

There is currently a built-in list of “naughty words” that your puzzles are scanned for, and removed 
if they are randomly created from the extra fill letters in your puzzle.  Now you can add your own 
set of "excluded words" to this built-in list, in case you have your own particular slang/derogatory 
words you don’t want to accidentally get created in your puzzles.  You can have a different list for 
each language/alphabet you choose. Each word in the list must be on a separate line and must only 
consist of letters from the language/alphabet you choose.  If a word in your list has letters from 
other than your currently-chosen language/alphabet or is a duplicate of one of the built-in known 
bad words, it will be quietly ignored. 

Note: This feature is not available in the Lite version of this software. 

Whirlwind WordSearch: Remember Current Settings

Choose this item to take a "snapshot" of the current document's settings (including title, subtitle, 
puzzle size & shape, printing options, etc.)  Afterward, all new documents you create with 
Whirlwind Wordsearch will start already filled in with these settings as defaults.  It does not 
remember your current word list.  That will always be empty in new documents. 

Whirlwind WordSearch: Change Current Colors to B&W

Choose this item to quickly change all font/grid colors to black and white (and gray), best used 
when printing a book or worksheet.  This changes the colors in the currently opened document, and 
does not save them for other documents.  If you want all future new documents to have this setting, 
you can choose this menu item, then immediately choose “Remember Current Settings” above. 

File: New:

Creates a new empty word-search window, which you can build a new puzzle from, and then save 
as a file if you want to open it later.  You can have multiple word search windows open at a time 
and switch between each of them to work on. 

If you are the type of person who reads user manuals thoroughly, then you deserve a special prize 
now!  There is a hidden "easter egg" feature, if you have the English language/alphabet set as the 
default!  Hold down the Option key when choosing the "New" menu item, and the new window 
will open in “Magic Mode”, and if you have the English language chosen, you will see a new 
button under your word list: [Random Word Fill]. 

If you click the button, your word list will fill with a random list of (English) words.  With bigger 
puzzle sizes, you get more and longer words.  This "easter egg" is perhaps not useful to everyone, 
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but this can be fun for finding unusual words, or quickly pre-filling a large puzzle to see its layout.  
And yes, there are probably more easter eggs hiding elsewhere. 

File: Open/Save:

These items allow you to save an existing puzzle to a file (including the word list and all your 
settings), so it can be re-opened later.  These files can also be sent to other Whirlwind WordSearch 
users who can then open and use the puzzle too.  These special files can only be opened by 
Whirlwind WordSearch. 

Note: This feature is not available in the Lite version of this software. 

File: Export Files…:

Choose to export the puzzle image, or the answer image for importing to other software.  This item 
will be disabled if you have not yet created a puzzle.  You must choose a directory to save your 
files, and the puzzle/answer files will be saved with file names and the format you chose previously 
in the Settings window (under the Export tab.) The settings you choose here will be remembered 
for future export sessions.  See section 3.13 for additional information on exporting. 

File: Print:

This opens the print dialog and allows you to print one or more copies of your puzzle page (and/or 
answer page) to a printer. 

There is a hidden "easter egg" feature here too.  You can print your empty word search grid as an 
empty template. First set up all the layout options you want to display the shape and grid as you 
like.  Then hold down the Option key when choosing the "Print" menu item, and the puzzle page 
will print, but just as the empty grid, with no letters inside.  This was requested long ago by a user 
who wanted a template to write in their own word search puzzles. 

Edit: Copy Formatted:

#1-Puzzle Grid, #2-Answer Grid, #3-Word List as Text: Choose these to copy a (high quality 
PDF) graphic image of the Puzzle Grid or Answer Grid, or the text list of words, to the clipboard.  
These items will be disabled if you have not yet created a puzzle. 

Edit: Copy Puzzle & Answer as Text:

This will copy a text representation of the puzzle grid, answer grid, and word list to the clipboard.  
This is most useful if you are an advanced user who wishes to extract the raw puzzle text, and do 
your own fancy formatting (also see “File Menu:Export WordSearch:” above as another flexible 
alternative.)  The puzzle and answer grid of letters are written in a tab-delimited format, as well as a 
“pretty-printed” format.  This text can easily be imported/pasted into word processors or 
spreadsheet programs for further formatting.  This item will be disabled if you have not yet created 
a puzzle. 
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Edit: Copy Formatted Word List as Text:

Copy the word list as a formatted carriage-return-separated list to the clipboard.  The words will be 
capitalized and sorted and numbered per your choices in the Page Details tab.  Available after you 
create a puzzle 

Action: Create Puzzle:

Choose this to generate a word search puzzle from the words and settings you have chosen.  This 
menu item is equivalent to clicking the "Create" button on the main window. 

Action: Stop:

Choose this to interrupt and halt the creation of a word search puzzle in progress. 

Help: Whirlwind WordSearch User Guide:

This menu item opens a window that displays this user guide.  You can adjust the size of the text by 
resizing the window larger or smaller.  You can also choose "Print" from the File menu, to print a 
copy of the user guide if you like. 

Help: Whirlwind WordSearch Introduction/Tutorial:

This menu item opens a window that displays a multi-tabbed quick introduction, illustrating some 
of the features of the software.  It will open each time you run the software, unless you un-check 
the “Show this window on startup" box at the bottom of the window.  You can always open it later, 
by choosing this menu item. 

Help: Feature Comparison:

This menu item opens a window that displays the feature differences between the Lite and the Full 
versions of this software. 

Help: Contact Author:

This menu item opens an e-mail that you can update with any questions, bugs, or feature requests 
and send to me.  It automatically contains some information about which version of the software 
you are using, which can help me answer questions for you. 

Help: Rate/Review Whirlwind WordSearch:

This menu item opens an Apple App-Store window that lets you add your rating, and write a review 
for this software, letting others know how you like it.  Please consider rating it and possibly writing 
a sentence or three about it! 

Help: Visit Whirlwind WordSearch Product Web Page:

This menu item opens a browser window that displays the product web page for this software. 
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Help: Visit Company Web Site:

This menu item opens a browser window that displays my company web page, showing all my 
other interests and projects. 
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5. Writing Word Search Software is Easy, Right?
When I began writing this software many years ago, I thought a word-search program would be 
fairly easy to create.  After all, the software just needs to lay a list of words randomly into a grid, 
and fill the rest of the empty spaces with random letters.  What's so hard about that? 

As it turns out, some of the free word-search web sites and applications out there do exactly this, 
and you get what you pay for.  But I quickly found that there were some rather interesting, subtle 
and complex problems that arise with those generated puzzles if you just stop there. 

For example, every once in awhile, those randomly sprinkled letters will happen to accidentally 
create another copy of one of your own word list words in the puzzle. Uh oh, that means that people 
will find their word in two places, not one… or worse, they will just see the wrong one, and tell you 
that your answer key is incorrect!  So, how did I fix this?  After generating a puzzle, my software 
searches the entire puzzle looking for duplicate copies of each word, and if a randomly created 
duplicate word is found, it changes a letter or two to something else.  It then re-checks the entire 
puzzle again in case that change in turn creates a duplicate of some other word.  It repeats this 
"clean-up" until no more problems are found. 

Or how about this one… sometimes those random letters will form "naughty words."  Uh oh!  
Perhaps the students may snicker and enjoy finding them, but teachers and parents may not find 
them so humorous on a school hand-out.  So my software searches for and removes any of these 
accidentally formed words too.  But wait… the software can make puzzles in different languages!?  
Yes, you guessed it.  It must have a list of "naughty words" in each language as well!  By the way, 
the research I had to do to obtain lists of dirty words in many different languages is probably 
worthy of a short humorous novel of its own. 

One of the problems that might seem quite simple to the user, but turns out 
to be quite complex to the software engineer, is how to correctly handle the 
"Allow words to overlap/share letters" feature.  If I simply checked for two 
words that share one or more letter grid spaces, that is easy.  But words can 
also cross over/between each other at diagonals, such that they don't 
actually "share" any letters.  How do I detect these?  It turns out there are 
some elegant geometry calculations for “Determining if two line segments 
intersect”, so I chose one and got it working (in C++) to find out if words 
"overlap."  My high school teacher was right when he said I would need 
that geometry someday! 

Many other important "finishing touches" were needed to make this software something I am proud 
of, for example, using terse "user interface" wording on each of the checkboxes and buttons that 
make sense, writing and updating this giant user guide, testing the software to find and fix yet more 
complex problems… it is quite a labor of devilishly detailed love.  And I hope you love it too!  If 
you do, let me know… write a review… and tell your friends! 

And if you don’t love it, let me know that too.  Please tell me if anything is broken or confusing, 
and I will endeavor to fix it.  If you have ideas for what you would like to see changed or added, 
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please read section 6 below :-)  If you are interested in a behind-the-scenes essay on the creation of 
this software, you may enjoy reading my blog entry here: 

http://schwansongs.blogspot.com/2013/02/a-whirlwind-of-words.html 

6. Future Features, What's Next?
What new things will be added to this software?  Some of that is up to you, the user of this 
software.  Feel free to let me know what features you would most like to see, and I will collect your 
requests and work on adding the most-requested features into future updates.    I have had many 
people suggest new features or changes, and most of them are now added.  Please send your 
suggestions, critiques, or kudos to note@schwansongs.com or schwansongs@gmail.com 

Here are some features that are already on my to-do list.  Tell me which you want to see! 
• Better workflow/automation support for making puzzle books (coming in 5.0!) 
• Localize this application into multiple languages. 
• Define your own puzzle shapes (coming in 5.0!) 
• Choose other grid line styles/patterns. 
• Other export formats and options. 
• Add more alphabets/languages. 
• Publish more secret "easter egg" features. 
• Make an iPhone/iPad “game” that interactively plays these puzzles. 
• Have built-in themed word-lists that can be auto-loaded (in each language.) 
• Make a "universal language" option to mix multiple languages in one puzzle.
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